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About This Document 

Introduction 

This document will detail information necessary to administer the CT for Siebel 7.0 
Solution. It is assumed that the full system has been installed (see the Avaya CT for 
Siebel 7.0 Installation Guide) before any administration commences. 
Administering the system can be as limited or comprehensive as desired. The CMS Data 
Feed and the Agent States must be set up, but all other configuration is optional (such as 
setting commands and events). 
 

About This Guide 

This guide contains information on how to administrate Avaya CT for Siebel 7.0. It is 
assumed that the procedures detailed in the Avaya CT Integration for Siebel Installation 
Guides (Server and Client) have been completed. 

NOTE: Avaya CT Integration for Siebel 7.0 is referred to as Avaya CT For Siebel 
7.0 throughout this document.  

 

Document Font Conventions 

This document contains different font usage for referencing purposes. 

• Italics refer to a field. 

• Bold refers to either a figure or table. Bold may also be used as a subheading 
for contingencies (i.e: If you are installing on Siebel 99:). 

• Underlined italics refer to a figure location. 

• “Quoted Bold italics” refer to another section of the manual. 

• Bold underline refers to a URL 

• “Quotes” denote buttons to click, strings to type into fields, default strings, or 
file paths. 
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Related Documents 

The following is a list of documents related to Avaya Computer-Telephony for 
Windows® NT, Avaya CT for Siebel 7.0 and Siebel Enterprise Applications. 

Avaya  Computer Telephony Documents 
The following is a list of documents related to Avaya Computer-Telephony for 
Windows® NT.  These documents are stored on the Avaya Computer-Telephony CD-
ROM (Not Provided) under the \Docs folder in the root directory.  See Table B. 

NOTE: The documents on the CD-ROM are in the Portable Document Format 
(PDF) and viewable with Adobe Acrobat Reader.  You can install Adobe Acrobat 
Reader by following the instructions on the packaging that came with the CD-
ROM or by referring to “Installing the Acrobat Reader and Online Product 
Documentation” in Chapter 1 of the Avaya CT Siebel 7.0 Installation Guide.  
The Adobe Acrobat Reader can also be downloaded from the web, using the 
following URL: http://www.avaya.com/ 

 
Table B - List of Documents on Avaya Computer-Telephony CD-ROM 

Avaya Computer-Telephony Documents File Name (PDF) 

Telephony Services Administration and 
Maintenance  

NETMANGD.PDF 

 

Avaya CT for Siebel 7.0 Documents 
The following is a list of documents related to Avaya CT for Siebel 7.0.  These 
documents are stored on the Avaya CT for Siebel 7.0 CD-ROM under the \Docs folder in 
the root directory.  See Table C. 

 
Table C. List of Documents on CD-ROM 

Avaya CT for Siebel 7.0 Documents  File Name (PDF) 

Agent User Guide USER.PDF 

Installation Guide INSTALL.PDF 

Administrator’s Guide  ADMIN.PDF 

 

 

 

http://www.avaya.com/
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Siebel Enterprise Applications Documents 
The following is a list of documents related to Siebel Enterprise Application.  These 
documents are stored on the Siebel Bookshelf CD-ROM (Not Provided) under the \Docs 
folder in the root directory.  See Table D. 

 
Table D. List of Documents on Siebel Bookshelf CD-ROM 

Siebel Bookshelf Documents  

CTI Guide 

Siebel Tools Guide   

Application Administration 

Customer Support 

For questions about Avaya CT for Siebel 7.0, customers can call the AVAYA Support 
Center at:  1-800-242-2121 and follow the voice prompts for Call Center Solutions 
(Avaya CT Products) and then Avaya CT for Siebel 7.0. 
 

How to Comment on this Document 

AVAYA welcomes your comments on this document.  Please complete the reader 
comment card at the end of this document and return it. 
Your may send additional comments to: 
AVAYA, Inc. 
Product Development Team, CRM Professional Services 
8744 Lucent Boulevard, 
2nd Floor 
Highlands Ranch, CO 80239 
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Chapter 1:  Administering the CMS Messaging 
System 

Introduction 

One of the key features of CentreVu CT for Siebel is the CMS Messaging service. This 
service will work seamlessly with Siebel to scroll real-time CMS data, based on 
Distribution Groups, to different skills and agents. 

How This Section Is Organized 

• How to access the CMS Messaging Service Control Panel. 

• An overview of the CMS Messaging application. 

• Configuring the CMS Administrator 

• How to create and define data for a CMS Distribution Group. 

• How to define a skill or reporting group. 

• An index of all legal CMS items available to the scrolling marquee. 

Applications Required 

• CVCT for Siebel Administrative Tool (Server) 
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Assigning Parent Divisions 
Parent divisions are useful for masking what agents and CMS Items will be visible 
before actually creating the profiles. This is useful for defining divisions for certain 
agents. 

1. Load the CVCT Administration Program. 

2. Go to CMS->Parent Divisions. 

3. The Parent Divisions Menu will appear. 

4. Enter the parent division name in the top field. NOTE: The parent division must 
already exist in Siebel, and must be spelled exactly as it is entered in Siebel. 

5. Click on “Add” to add the Parent Division to the list. 

6. All divisions in the list will be the only ones available in the CMS Messaging 
Service Control Panel. If this list is empty, all Siebel Agents and Divisions will be 
available. To delete  a division in the list, highlight the division and click 
“Delete.” 

 

 
Figure 1: Adding Parent Divisions 

 

Accessing The CMS Messaging Service Control Panel 
To access the Messaging Configuration, load the CVCT for Siebel Administrator Tool on 
the Server where the CMS Data Feed Resides (this will not function on a Client-Installed 
Administrator Tool).  

 
• Go to Service -> CMS -> Broadcast Messaging 
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Overview: Administering the CMS Messaging 

Building and changing Distribution Groups are the key activities to using the CMS 
Reporter, to keep your Siebel Agents informed. The CMS Administrator is a control 
panel in which to create, modify or delete a CMS Distribution Group. Refer to Figure 2 
for the interface. 
 

 
Figure 2 - CMS Administrator Application 

 
This view is accessible through the CMS Service Control Panel: click on the Administer 
to bring up this application (see “Accessing the CMS Messaging Control Panel” earlier 
in this chapter). 

 
Creating a Distribution Group involves four basic steps: 

1. Creating and naming the Distribution Group. 

2. Defining the CMS Data Items for the Distribution Group. 

3. Define the switch calls for the Distribution Group. 

4. Define Siebel Divisions for the Distribution Group. 
 
Each of these steps will be detailed within this chapter. 
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Creating A New Distribution Group 
1. Click on the Add Button in the lower left-hand corner. 

2. A text box will appear, prompting for the name of the new Distribution Group (see 
Figure 3). 

 
       Figure 3 - Creating a New Distribution Group 

 
 

NOTE: After “OK” is clicked, providing the Distribution Group is not 
duplicated, the Distribution Group will appear under the Distribution Groups 
View. 

 

Defining CMS Data Items For A Distribution Group 
1. Select the Distribution Group you wish to define CMS data for in the Distribution 

Groups View. 

2. In the Table Selector, select the table the CMS data resides in. 

Available Tables: 

• Skill, Agent, VDN and Trunk Group 

3. Choose any of the available items in the Available Items View by clicking the check 
box to the left of the desired entry. 

4. Add the selected items to the Items for Distribution View by clicking on the right-
pointing arrow between the Available Items View and the Items for Distribution 
View. 

NOTE: You may add items more than once with different skills/names. 

5. You may remove any items from the distribution view by highlighting the item and 
clicking on the left-pointing arrow between Available Items View and the Items for 
Distribution View. 

6. You may select another table at any time.  The Items for Distribution List Items will 
not disappear when this is done.  In fact, Distribution Groups can contain items from 
multiple tables, groups, etc. 
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Defining Item Properties For The Distribution Group 
1. Select the Distribution Group you wish to define item properties for in the 

Distribution Groups View. 

2. Select an item in the Items for Distribution View list. 

3. In the Skill/Group Indicator Field, enter the skill or group number. 

4. The label in the Label Field will automatically set itself to the name of the CMS Item 
plus the skill/grp number in parenthesis.  To change the label, enter the label name 
in the Label field. 

5. Repeat Steps 1-4 for all items in the Items for Distribution List. 
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Defining Siebel Divisions 

Siebel Divisions must be defined within Siebel before they may be used in the 
Administrative Tool. 

1. Select the Distribution Group you wish to define switch skills for in the 
Distribution Groups View. 

2. Choose any of the available items in the Available Divisions View by clicking the 
check box to the left of the desired entry. 

3. Add the selected items to the Divisions for Distribution View by clicking on the 
right-pointing arrow between the Available Divisions View and the Division for 
Distribution View. 

4. You may remove any items from the distribution view by highlighting the item 
and clicking on the left-pointing arrow between the Available Divisions View 
and the Divisions for Distribution view. 

 

Defining Agents 

Individual agents within a Distribution Group may also be selected. This is optional -- 
If no agents are specified, the data will go to the entire group. If one or more agents are 
selected, it will only go to those agents. 

1. Select the Agent in the Available Agents View. 

2. Choose the agent by moving the highlighted agent and clicking the right-
pointing agent selector. 

3. Remove an agent by clicking the left-pointing agent selector. 

 

Editing Existing Distribution Groups 
To edit existing Distribution Groups, highlight the Distribution Group in Distribution 
Groups  View, and edit the Distribution Group as desired, then exit. The changes will be 
instantaneous. 

CMS Data Items 
The Skill Items give details about an entire skill of agents – they are useful to inspect the 
overall skill performance. 
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CMS Table 1 - Skill Items: 

Item Name Definition 

Calls in Queue Number of calls waiting in the split/skill queue. 

Oldest Call in Queue The time the oldest call has been waiting. 

Average Speed of 
Answer 

The queue’s average response time to incoming 
calls. 

ACD Calls Number of calls answered by an agent. 

Average Talk Time The average time of call for all calls received. 

Abandon Calls Number of calls abandoned by the caller. 

Average Abandon 
Time 

The average time for the abandoned calls. 

Service Level Number of seconds calls must be handled within 
to be acceptable 

Abandon Calls 
within Service Level 

Number of abandoned calls within the service 
level. 

Extension-In Calls Calls within the skill that were made 

Extension-Out Calls Calls made outside of the call center. 

Agents Staffed The number of Agents currently logged into the 
skill. 

Agents Available The number of Agents currently in Ready Mode. 

Agents on ACD Calls The number of Agents currently servicing ACD 
Calls. 

Agents in After-Call 
Work 

The number of Agents currently in After Call 
Work Mode. 

Agents in AUX-Work The number of Agents currently in Auxiliary 
Work Mode. 

Agents in Ring The number of Agents with telephones alerting. 

Agents in Other State The number of Agents currently in Other Mode. 

Estimated Wait-Time 
at Top Priority 

The estimated wait time for a top priority call. 

Estimated Wait-Time 
at High Priority 

The estimated wait time for a high priority call. 

Estimated Wait-Time 
at Medium Priority 

The estimated wait time for a medium  priority 
call. 

Estimated Wait-Time 
at Low Priority 

The estimated wait time for a low priority call. 
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CMS Table 2- Trunk Group Items: 

The Skill Items give details about an entire skill of agents – they are useful to 
inspect the overall skill performance. 

 
Item Name Definition 

Total Trunks Number of trunks assigned to the trunk group. 
In-Use Trunks Number of trunks that are currently busy. 
Maintenance Busy 
Trunks 

Number of In-Use Trunks that are maintenance-
busy 

Inbound Trunks Number of trunks that are busy on inbound calls 
Outbound Trunks Number of trunks that are busy on outbound calls 

 
CMS Table 3 – Agent Items: 

The Agent Items give details about a specific agent – these may be used to 
evaluate an agent’s performance. 

Item Name Definition 

Average Answer Time The average time for the agent to answer calls. 
Work Skill Skill of the call being handled. 
ACD Calls Number of calls to split/skill & handled by the 

agent 
Average Talk Time The average time it takes this particular agent to 

handle a call, based on the average of calls taken. 
Abandon Calls Number of calls abandoned while ringing. 
Average Abandon 
Time 

Average time callers waited before abandoning. 

Abandon Calls while 
on Hold 

The total number of calls that hung up when the 
agent placed the caller on hold. 

Extension Extension number of the agent. 
AUX Work Reason 
Code 

The reason provided by the agent to enter Auxiliary 
Mode. 

Extension-In Calls The number of intra-skill calls made by the agent. 
Extension-Out Calls The number of external calls from the Call Center 

made by the agent. 
Redirect on No-
Answer Calls 

Calls not answered and redirected back to queue. 

Agent State Current work-mode and direction. 
Agent Time in State Length of time agent has been in work-mode. 
Agent Duration in 
State 

The amount of time which has elapsed since the 
agent has changed states. 

Call Direction Direction of the current call. 
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CMS Table 4 – VDN Items: 

Inspection of VDNs is useful to gauge phone logistics at each extension. 

Item Name Definition 

Calls in Queue Number of In-Vector calls in ACD split/skill queue. 
Oldest Call in Queue The time the oldest call has been waiting. 
Average Speed of 
Answer 

Switch Based Rolling Average Speed of Answer. 

Lookahead Attempted 
Calls 

Number of look-ahead interflow attempts to this 
VDN. 

Lookahead Completed 
Calls 

Number of look-ahead interflow completions to this 
VDN. 

ACD Calls Number of incoming calls answered by an agent. 
Average Talk Time The average talk time for this VDN. 
Abandon Calls Number of incoming abandoned by the caller. 
Average Abandon 
Time 

Average Time callers waited before abandoning. 

Vector The vector number this VDN is assigned. 
Redirect on No-
Answer Calls 

Number of calls not answered and redirected back 
to system. 

Abandon Calls while 
in Queue 

Number of calls abandoned while in a queue. 

Abandon Calls while 
Ringing 

Number of calls abandoned while ringing at agent. 

Abandon Calls while 
on Hold 

Number of calls abandoned while on hold. 

Incoming Calls Number of inbound calls directed to this VDN. 
Busy Calls Number of inbound calls given a busy signal by the 

PBX. 
Disconnected Calls Number of inbound calls disconnected by the PBX. 
Flow-In Calls Number of calls redirected into this VDN 
Flow-Out Calls Number of inbound calls redirected to another 

destination 
Interflow-Out Calls No. of flow-out redirected to off-premise 

destination. 
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Cleaning the Call Database 

The Call Database is used to transfer items between agents throughout the workday, so 
the database is constantly expanding. Of course, the data stored is often a temporary 
measure, and rarely serves more than to take up space in the database. 
As such, it is recommended to clean the database, to delete old data files and keep the 
database down to a manageable size. 
 

1. Start SQL Enterprise Manager. 

2. Expand the SQL Server that the Call Database was created on. 

3. Expand the “Management” Folder. 

4. Expand the “SQL Server Agent” Folder. 

5. Right click on “Jobs” and select “New Job…” (see Figure 4). 

6. New Job will appear.  In the Name field, type “Clean CallData Table” 

7. In the Category field, select “Database Maintenance” 

8. In the Owner field, select “sa” 

 
Figure 4 - New SQL Job 

9. Click on the “Steps” tab. 

10. Click on “New…” (see Figure 5, overleaf). 

11. In the Step Name field, type “exec sp_CleanTable” 

12. In the Type field, select “Transact-SQL Script (TSQL)” 

13. In the Database field, select the database name that was used in the Call DB 
Builder. 

14. In the Command field, type “EXEC sp_CleanTable” 

NOTE: This is case sensitive. 
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Figure 5 - Job Step Editor 

15. Click “OK” 

16. Click on the “Schedules” Tab. 

17. Click “New Schedule…” 

18. In the Name field, type “Daily Clean Out of Call Data Table” 

19. Select “Recurring” and click “Change…” 

20. In the Occurs field, select “Daily” 

21. Select an appropriate time for this to run.  It is recommended 12:00AM be used. 

22. Click “OK.” 

23. Click “OK.” 

24. Click “OK.” 

25. The job is now scheduled.  Click on the Job. 

26. Right click on the Job and select “Start Job” 
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Chapter 2: Modifying Agent States 

Introduction 

The Change Agent State Applet will allow the Avaya CT for Siebel 7.0 Agents to select 
the current work mode from a pick-list applet. The Auxiliary Work Mode may also be 
customized with Reason Codes, allowing the agent to file the cause for entering Aux 
Work Mode. These codes will be filed within the CMS. 
 

How This Section Is Organized 

• This section illustrates and instructs how to properly configure the applet. 

 

Notes Regarding This Section 

This applet was set up during the install with default values. This chapter will allow the 
administrator to set customized agent states.  
 

Accessing the Add Agent State Configuration Menu 

To modify the valid Agent States, enter the Administrative Tool and choose Service -> 
Wizard -> Add Agent States (the Avaya CT Siebel Applets must be installed). Provide 
the Siebel Login when prompted, and the configuration menu will appear (see Figure 6, 
overleaf).  
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Figure 6 - Change Agent State Configuration Menu 

 
1. The Agent State box will have the valid work codes. These will be the codes fed 

into the CMS, not the codes that will be shown to the agents. Additional Aux 
Reason Codes (i.e., over 10) may not be added. All NUMBERS are Aux Reason 
Codes. 

2. The Display Value will be the name of the code, which will appear in the Agent’s 
pick-list. For the Aux Reason Codes, (numerical Aux Code/Agent States) a quick 
description must be entered.  

3. Click “OK” when satisfied with the changes. These changes will become instantly 
available. 

4. In Figure 7, the actual Change Agent State applet is illustrated as it will appear in 
a Avaya CT for Siebel Client. The Mode Field denotes the value entered in the 
Agent State box, and the Description Field denotes the string entered as the 
Display Value. 

 
Figure 7 - The Change Agent State Applet 
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Chapter 3:  Configuration Parameters 

Introduction 

The AVAYA Avaya CT for Siebel 7.0 package comes with a host of configuration 
parameters to help customize the package as much as possible. 
This chapter will guide you through the following: 

• Each parameter that has been added to Siebel’s configuration views. 

• Which parameters are required to be set, and which ones are optional. 

• Valid settings for each of these parameters. 

• A description of each parameter. 

• The default value, if applicable. 

 

How This Section Is Organized 

This section is comprised entirely of configuration parameters information. 
 

About Configuration Parameters 

Configuration Parameters instruct the application how to behave.  They are similar to 
“preferences”.  Avaya CT for Siebel 7.0 offers many configuration parameters to tailor it 
to meet requirements. 
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Complete List Of Required Parameters 

The parameters in this section are required.  Avaya CT for Siebel 7.0 will not start 
without these parameters. 
 
 

Name Driver:Server 

Type String 

Values <Open> 

Need? REQUIRED 
 
This is the T-Link name of the primary Avaya CT Server.  The T-Link contains the 
Server name, and is formatted as follows: 
VENDOR#NODE#SERVICE#SERVER 
(ex. AVAYA#AVAYA_ECS#CSTA#CTSERVER) 

 
 

Name Driver:BackupServer

Type String 

Values <Open> 

Need? REQUIRED 
 
This is the T-Link name of the secondary Avaya CT Server.  The T-Link contains the 
Server name, and is formatted as follows: 
VENDOR#NODE#SERVICE#SERVER  
(ex. AVAYA#AVAYA_ECS#CSTA#CTSERVER) 
 
 

Name Driver:CVCTUSER 

Type String 

Values <Open> 

Need? REQUIRED 
 
The CVCTUSER parameter instructs Avaya CT for Siebel 7.0 what user to login with.  If 
Integrated Security is in use, the $NT$ value will need to be used. 
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Name Driver:CVCTPassword 

Type String 

Values <Open> 

Need? REQUIRED 
 
The CVCTPassword parameter instructs Avaya CT for Siebel 7.0 what password to use 
when logging on with the username specified in the Driver:CVCTUSER parameter.  If 
Integrated Security is in use, this field should be omitted. 
 
 

Name Driver:LicensePath 

Type String 

Values <Open> 

Need? REQUIRED 
 
This is the path to the registration file. Refer to “Registration” in Chapter 8 of the Server 
Installation Guide. 
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Complete List Of Optional Parameters 

The parameters in this section are optional.  Avaya CT for Siebel 7.0 will start without 
these parameters, but they may be used to enhance functionality. 
 

Name Driver:CTIDSN 

Type String 

Values <Open> 

Need? OPTIONAL 
This is the name of the system ODBC Data Source Name that is used to access the CTI 
database. 

 
Name Driver:BackupCTIDSN 

Type String 

Values <Open> 

Need? OPTIONAL 
This is the name of the system ODBC Data Source Name that is used to access the 
backup CTI database. 
 

Name Driver:LogDSN 

Type String 

Values <Open> 

Need? OPTIONAL 
 

This is the name of the system ODBC Data Source Name that is used to access the 
Logging database. 

 
Name Driver:LogUser 

Type String 

Values Open 

Need? OPTIONAL 
This is the name of the user that has permission to access the Database logger tables. 
 

Name Driver:LogPwd 

Type String 

Values MSSQLServer 

Need? OPTIONAL 
This is the password for the LogUser database account. 
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Name Driver:TSIsAliveInt 

Type Integer 

Values <Open> 

Need? OPTIONAL 

Default 30 
This is the time in seconds that the driver will wait in between polls to the Tserver to see 
if service is still up. 
 

Name Driver:NoOfInitialThreads

Type Integer 

Values 1 - <= <MaxNoOfThreads 
param> 

Need? OPTIONAL 
This is the number of threads that the driver will create on startup to process jobs.  The 
default value is 1.  The maximum value is limited by the value of the MaxNoOfThreads 
parameter. 

 
Name Driver:MaxNoOfThreads 

Type Integer 

Values > than 
NoOfInitialThreads 

Need? OPTIONAL 

Default 50 
This is the maximum number of threads that the driver will create to process commands 
and events.  Once this number has been met, jobs will wait until a thread becomes 
available. 
Caution: If this number is exceeded by an agent, the result may severely affect the server 
performance. 

Name Driver:TimeoutExtraThreads

Type Integer 

Values <Open> 

Need? OPTIONAL 

Default 500 
This value determines how long threads not created at startup remain after sitting idle in 
the thread pool. 
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Name Service:AgentID 

Type String 

Values {@AgentId} 

Need? OPTIONAL 
This is the switch id of the agent.  The value indicates that this is taken from a variable  in 
Siebel. 
 

Name Service:AgentPin 

Type String 

Values {@AgentPin} 

Need? OPTIONAL 

 
This is the switch password of the agent.  The value indicates that this is taken from 
variable in Siebel. 

 
Name Service:DNList 

Type String 

Values {@DNList} 

Need? OPTIONAL 
This is the station extension that represents the agent’s telephone extension.  The value 
indicates that this is taken from variable in Siebel. 

 
Name Service:QueueID 

Type String 

Values {@QueueId} 

Need? OPTIONAL 
This is the queue that the agent will log into in a non-EAS environment. 

 
Name Service:HasSAC 

Type Boolean 

Values TRUE 
FALSE 

Need? OPTIONAL 

Default FALSE 
This parameter turns on the Send All Calls feature for all agents that are members of this 
configuration. 
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Name Service:HasDeflect 

Type Boolean 

Values TRUE 
FALSE 

Need? OPTIONAL 

Default FALSE 
 
This turns on the deflect call feature.  This parameter is closely related to the 
Service:HasSAC parameter.  The driver will not allow both HasSAC and HasDeflect to 
be enabled.  If both are set to TRUE, HasSAC will take precedence.  

 
Name Service:VoiceMail 

Type Integer 

Values <Open> 

Need? OPTIONAL 
 
This is the value of the voice mail extension that calls will deflect to in the instance that a 
phone number parameter is not passed in with the deflect call command from Siebel.  If 
this parameter is not set and no phone number is passed in from Siebel, the deflect call 
command will fail and the call will remain at the station. 

 
 

Name Service:HasPendingWorkMode 

Type Boolean 

Values TRUE 
FALSE 

Need? OPTIONAL 

Default FALSE 
 
This parameter will enable the Pending Work Mode feature.  The default value is 
FALSE. This may only be turned on if the appropriate license is purchased. 
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Name Service:AutoLoginAgent 

Type Boolean 

Values TRUE  
FALSE 

Need? OPTIONAL 

Default FALSE 
 
This feature, if set to TRUE will log the agent into the switch when they log in to Siebel.  
The default value for this parameter is FALSE. 

 
 

Name Service:AgentLogoutOnExit 

Type Boolean 

Values TRUE  
 FALSE 

Need? OPTIONAL 

Default FALSE 
 
This parameter, if set to TRUE will log the agent out of the switch when they log out of 
Siebel. 

 
 

Name Service:DefaultAgentAvailState

Type String 

Values MANUAL_IN  
AUTO_IN 

Need? OPTIONAL 

Default MANUAL_IN 
 
This instructs Avaya CT for Siebel 7.0 what Available state to toggle the agent into upon 
logging in. 
MANUAL_IN: Toggles from Not Available to Available (Manual In) 
AUTO_IN: Toggles from Not Available to Available (Auto In) 
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Name Service:DefaultAgentUnavailState

Type String 

Values MANUAL_IN  
AUTO_IN 

Need? OPTIONAL 

Default AUX 
 
This instructs Avaya CT for Siebel 7.0 what Not Available state to toggle the agent into 
when the “Not Ready” button is used. 

 
 

Name Service:LoggingPrefix 

Type String 

Values not NULL 

Need? OPTIONAL 

Default NULL 
 
This parameter tells the driver to log CTI information for this agent in the Log database.  
If this parameter is set, the agent extension must start with this value in order for these 
values to be logged.  For example, if the agent extension is 123 and logging prefix is set 
to %, the extension set in the Siebel teleset must read %123.  If loggingPrefix is set to 
NULL(“”), no logging will take place. 
 
 

Name Service:DefaultAgentStateAtLogin 

Type String 

Values MANUAL_IN, AUTO_IN, ACW 

Need? OPTIONAL 

Default AUX 
 
This will place the agent into a specified state other than AUX the available values are 
MANUAL_IN, AUTO_IN and ACW. 
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Manual Configuration Procedure 
In order to configure the system manually, follow the steps below. 

1. Launch Siebel. 
2. Click on the “Home” Tab. 
3. Click on “Communications Administration” 
 

 
Figure 8 – Home Tab 

 
4. Click on “All Configurations” 
 

 
Figure 9 – All Configurations View 
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5. Click on New, Type in the name of the config (Avaya CT is depicted) Click on 
the Import Config button. 

 

 
Figure 10 – Configurations View 

 
6. Next, the warning screen will appear. Click “Next” to continue. 
 

 
Figure 11 – Configuration Warning Screen 
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7. Choose all checkboxes and choose the AVAYA.DEF location (see Figure 12). 
Click OK. 

 

 
Figure 12– Import Configuration Screen 
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Chapter 4: Commands and Events 

Introduction 

This section delves a bit deeper into the Avaya CT for Siebel 7.0 Commands and Events, 
giving more information regarding the actual workings within the software. Therefore, 
neither the administrator nor user requires mastery of this section, but it provides some 
research reference. 
 

How This Section Is Organized 

• This section is comprised entirely of Command and Event Information and 
Parameters. 

Commands 

The following table details the commands (DeviceCommand and all respective 
parameters) supported by Avaya CT for Siebel 7.0. 
 

NOTE: Commands that have the <Open> parameter allow data attachments.  An 
unlimited number of data attachments may be attached to a call.  These 
attachments may be up to 8KB in size.  For Commands with the UUI field, only 
96-bytes of data may be stored in this field.   
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Table 5-1. Commands 

DeviceCommand Parameters Need? 

MakeCall PhoneNumber  
UUI 
<Open> 

REQUIRED  
OPTIONAL 
N/A 

AnswerCall NONE <VARIES> 

ReleaseCall NONE <VARIES> 

LogIn AgentId 
AgentPin 
ACDQueue 

REQUIRED 
REQUIRED 
OPTIONAL 

LogOut NONE <VARIES> 

HoldCall NONE <VARIES> 

UnHoldCall NONE <VARIES> 

RetrieveCall NONE <VARIES> 

TransferMute PhoneNumber 
UUI 
<Open> 

REQUIRED 
OPTIONAL 
<VARIES> 

TransferInit PhoneNumber 
UUI 
<Open> 

REQUIRED 
 OPTIONAL 
<VARIES> 

TransferComplete NONE <VARIES> 

ConferenceMute PhoneNumber 
UUI 
<Open> 

REQUIRED 
OPTIONAL 
<VARIES> 

ConferenceInit PhoneNumber 
<Open> 

REQUIRED 
<VARIES> 

ConferenceComplete NONE <VARIES> 

ForwardCall PhoneNumber 
<Open> 

REQUIRED 
<VARIES> 

CancelForwardCall NONE <VARIES> 

AutoIn NONE <VARIES> 

ManualIn NONE <VARIES> 

AfterCallWork NONE <VARIES> 

AuxReason 
 

ReasonCode 
Description 

REQUIRED 
OPTIONAL 

ChangeNotReadyState NONE <VARIES> 

SendDTMF Digits REQUIRED 
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Events 

The following events (DeviceEvent and all respective parameters) are supported by 
Avaya CT for Siebel 7.0: 

NOTE: Events that have the <Open> parameter allow the reception of data 
attachments from other agents.   

 
Table 5-2. Events 

DeviceEvent Parameters Values 

OnHold 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

CallID 
Device 
Cause 
 
 
 
 
 
 
 
 
 
 
 
 
      
 

<VARIES> 
<VARIES> 
ALTERNATE 
BUSY 
CALLBACK 
CALL_CANCELLED 
CALL_FORWARD_ALWAYS 
CALL_FORWARD_BUSY 
CALL_FORWARD_NO_ANSWER 
CALL_FORWARD 
CALL_NOT_ANSWERED 
CALL_PICKUP 
CAMP_ON 
DESTINATION_NOT_AVAILABLE 
DO_NOT_DISTURB 
INCOMPATIBLE_DESTINATION 
INVALID_ACCOUNT_CODE 
KEY_CONFERENCE 
LOCKOUT 
MAINTENANCE 
NETWORK_CONGESTION 
NETWORK_NOT_OBTAINABLE 
NEW_CALL 
NO_AVAILABLE_AGENTS 
OVERRIDE 
RECALL 
REDIRECTED 
REORDER_TONE 
RESOURCES_NOT_AVAILABLE 
SILENT_MONITOR 
TRANSFER 
TRUNKS_BUSY 
VOICE_UNIT_INITIATOR 
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DeviceEvent Parameters Values 

OnConference OldCallID 
NewCallID 
Device 
AddedDevice 
NumberOfPartiesCause 
OrigCallingDevice 
OrigCalledDevice 
OrigCollectedDigits 
OrigUUI 
OrigUCID 
DistributingDevice 
UCID 
 
  

<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
 
 

OnConnect 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CallID 
Device 
ANI 
DNIS
Cause 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
ALTERNATE 
BUSY 
CALLBACK 
CALL_CANCELLED 
CALL_FORWARD_ALWAYS 
CALL_FORWARD_BUSY 
CALL_FORWARD_NO_ANSWER 
CALL_FORWARD 
CALL_NOT_ANSWERED 
CALL_PICKUP 
CAMP_ON 
DESTINATION_NOT_AVAILABLE 
DO_NOT_DISTURB 
INCOMPATIBLE_DESTINATION 
INVALID_ACCOUNT_CODE 
KEY_CONFERENCE 
LOCKOUT 
MAINTENANCE 
NETWORK_CONGESTION 
NETWORK_NOT_OBTAINABLE 
NEW_CALL 
NO_AVAILABLE_AGENTS 
OVERRIDE 
RECALL 
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DeviceEvent Parameters Values 

OnConnect  
(con’t) 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
  
 
 
 
 
 
 
 
 

     Cause (con’t) 
 
 
 
 
 
 
CollectedDigits 
TrunkGroup 
TrunkMember 
Queue 
UUI 
Reason 
OrigANI 
OrigDNIS 
OrigCollectedDigits 
OrigUUI 
OrigUCID 
DistributingDevice 
UCID 
IIDigits 
FlexibleBilling 
Queue 
 
ConnectType
 
RedirectionDevice 
AgentState 
 
 
 
 
<Open> 
 

REDIRECTED 
REORDER_TONE 
RESOURCES_NOT_AVAILABLE 
SILENT_MONITOR 
TRANSFER  
TRUNKS_BUSY 
VOICE_UNIT_INITIATOR 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
 
INBOUND 
OUTBOUND 
<VARIES>  
IDLE 
INITIATED  
CONNECTED  
ALERTING 
HELD 
<VARIES> 
 
 
 
 
 
 
 
 



 

 

 Page    31 

© Copyright 2001, Avaya Inc. 

DeviceEvent Parameters Values 

OnDisconnect 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CallID 
Cause 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
UUI 

<VARIES> 
ALTERNATE 
BUSY 
CALLBACK 
CALL_CANCELLED 
CALL_FORWARD_ALWAYS 
CALL_FORWARD_BUSY 
CALL_FORWARD_NO_ANSWER 
CALL_FORWARD 
CALL_NOT_ANSWERED 
CALL_PICKUP 
CAMP_ON 
DESTINATION_NOT_AVAILABLE 
DO_NOT_DISTURB 
INCOMPATIBLE_DESTINATION 
INVALID_ACCOUNT_CODE 
KEY_CONFERENCE 
LOCKOUT 
MAINTENANCE 
NETWORK_CONGESTION 
NETWORK_NOT_OBTAINABLE 
NEW_CALL 
NO_AVAILABLE_AGENTS 
OVERRIDE 
RECALL 
REDIRECTED 
REORDER_TONE 
RESOURCES_NOT_AVAILABLE 
SILENT_MONITOR 
TRANSFER 
TRUNKS_BUSY 
VOICE_UNIT_INITIATOR 
<VARIES>  
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DeviceEvent Parameters Values 

OnDrop 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CallID 
Device 
Cause 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
UUI 
 

<VARIES> 
<VARIES>  
ALTERNATE 
BUSY 
CALLBACK 
CALL_CANCELLED 
CALL_FORWARD_ALWAYS 
CALL_FORWARD_BUSY 
CALL_FORWARD_NO_ANSWER 
CALL_FORWARD 
CALL_NOT_ANSWERED 
CALL_PICKUP 
CAMP_ON 
DESTINATION_NOT_AVAILABLE 
DO_NOT_DISTURB 
INCOMPATIBLE_DESTINATION 
INVALID_ACCOUNT_CODE 
KEY_CONFERENCE 
LOCKOUT 
MAINTENANCE 
NETWORK_CONGESTION 
NETWORK_NOT_OBTAINABLE 
NEW_CALL 
NO_AVAILABLE_AGENTS 
OVERRIDE 
RECALL 
REDIRECTED 
REORDER_TONE 
RESOURCES_NOT_AVAILABLE 
SILENT_MONITOR 
TRANSFER 
TRUNKS_BUSY 
VOICE_UNIT_INITIATOR 
<VARIES> 
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DeviceEvent Parameters Values 

OnHoldReconn
ect 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CallID 
Device 
Cause 
 
 
 
 
 
      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

<VARIES> 
<VARIES> 
ALTERNATE 
BUSY 
CALLBACK 
CALL_CANCELLED 
CALL_FORWARD_ALWAYS 
CALL_FORWARD_BUSY 
CALL_FORWARD_NO_ANSWER 
CALL_FORWARD 
CALL_NOT_ANSWERED 
CALL_PICKUP 
CAMP_ON 
DESTINATION_NOT_AVAILABLE 
DO_NOT_DISTURB 
INCOMPATIBLE_DESTINATION 
INVALID_ACCOUNT_CODE 
KEY_CONFERENCE 
LOCKOUT 
MAINTENANCE 
NETWORK_CONGESTION 
NETWORK_NOT_OBTAINABLE 
NEW_CALL 
NO_AVAILABLE_AGENTS 
OVERRIDE 
RECALL 
REDIRECTED 
REORDER_TONE 
RESOURCES_NOT _AVAILABLE 
SILENT_MONITOR 
TRANSFER 
TRUNKS_BUSY 
VOICE_UNIT_INITIATOR 
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DeviceEvent Parameters Values 

OnRinging 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CallID 
Queue 
CollectedDigits 
Cause 
 
 
 
 
 
 
 
 
 
 
 
 
 
      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
TrunkGroup 
TrunkMember 
UUI 
Reason 
OrigCallingDevice 
OrigCalledDevice  
OrigCollectedDigits 
OrigUUI 
OrigUCID  

<VARIES> 
<VARIES> 
<VARIES>  
ALTERNATE 
BUSY 
CALLBACK 
CALL_CANCELLED 
CALL_FORWARD_ALWAYS 
CALL_FORWARD_BUSY 
CALL_FORWARD_NO_ANSWER 
CALL_FORWARD 
CALL_NOT_ANSWERED 
CALL_PICKUP 
CAMP_ON 
DESTINATION_NOT_AVAILABLE 
DO_NOT_DISTURB 
INCOMPATIBLE_DESTINATION 
INVALID_ACCOUNT_CODE 
KEY_CONFERENCE 
LOCKOUT 
MAINTENANCE 
NETWORK_CONGESTION 
NETWORK_NOT_OBTAINABLE 
NEW_CALL 
NO_AVAILABLE_AGENTS 
OVERRIDE 
RECALL 
REDIRECTED 
REORDER_TONE 
RESOURCES_NOT_AVAILABLE 
SILENT_MONITOR 
TRANSFER 
TRUNKS_BUSY 
VOICE_UNIT_INITIATOR 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 



 

 

 Page    35 

© Copyright 2001, Avaya Inc. 

DeviceEvent Parameters Values 

OnRinging 
(cont’d) 
 

DistributingDevice 
UCID 
IIDigits 
FlexibleBilling  
<Open> 

<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 

OnTransfer 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

OldCallID 
NewCallID 
Device  
TransferredToDevice  
Cause 
 
 
 
 
 
      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
OrigCallingDevice 
OrigCalledDevice

<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
ACTIVE MONITOR 
ALTERNATE 
BUSY 
CALLBACK 
CALL_CANCELLED 
CALL_FORWARD_ALWAYS 
CALL_FORWARD_BUSY 
CALL_FORWARD_NO_ANSWER 
CALL_FORWARD 
CALL_NOT_ANSWERED 
CALL_PICKUP 
CAMP_ON 
DESTINATION_NOT_AVAILABLE 
DO_NOT_DISTURB 
INCOMPATIBLE_DESTINATION 
INVALID_ACCOUNT_CODE 
KEY_CONFERENCE 
LOCKOUT 
MAINTENANCE 
NETWORK_CONGESTION 
NETWORK_NOT_OBTAINABLE 
NEW_CALL 
NO_AVAILABLE_AGENTS 
OVERRIDE 
RECALL 
REDIRECTED 
REORDER_TONE 
RESOURCES_NOT_AVAILABLE 
SILENT_MONITOR 
TRANSFER 
TRUNKS_BUSY 
VOICE_UNIT_INITIATOR 
<VARIES> 
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DeviceEvent Parameters Values 

OnTransfer 
(cont’d) 
 
 
 

OrigCollectedDigits 
OrigUUI 
OrigUCID 
DistributingDevice 
UCID  
 

<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
 

OnCallInitiated 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CallID 
Device 
Cause 
 
 
 
  
 
 
 
    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
<Open> 

<VARIES> 
<VARIES> 
ALTERNATE 
BUSY 
CALLBACK 
CALL_CANCELLED 
CALL_FORWARD_ALWAYS 
CALL_FORWARD_BUSY 
CALL_FORWARD_NO_ANSWER 
CALL_FORWARD 
CALL_NOT_ANSWERED 
CALL_PICKUP 
CAMP_ON 
DESTINATION_NOT_AVAILABLE 
DO_NOT_DISTURB 
INCOMPATIBLE_DESTINATION 
INVALID_ACCOUNT_CODE  
KEY_CONFERENCE 
LOCKOUT 
MAINTENANCE 
NETWORK_CONGESTION 
NETWORK_NOT_OBTAINABLE 
NEW_CALL 
NO_AVAILABLE_AGENTS 
OVERRIDE 
RECALL 
REDIRECTED 
REORDER_TONE 
RESOURCES_NOT _AVAILABLE 
SILENT_MONITOR 
TRANSFER 
TRUNKS_BUSY 
VOICE_UNIT_INITIATOR  
<VARIES> 
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DeviceEvent Parameters Values 

OnOriginated 
 
 
  

CallID 
Device 
DNIS 
Cause 
Agent ID 
UUI 
<Open> 

<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 

OnDiverted 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

CallID 
Device 
Cause 
 
 
 
 
 
 
 
      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
UUI 
 

<VARIES> 
<VARIES> 
ALTERNATE 
BUSY 
CALLBACK 
CALL_CANCELLED 
CALL_FORWARD_ALWAYS 
CALL_FORWARD_BUSY 
CALL_FORWARD_NO_ANSWER 
CALL_FORWARD 
CALL_NOT_ANSWERED 
CALL_PICKUP 
CAMP_ON 
DESTINATION_NOT_AVAILABLE 
DO_NOT_DISTURB 
INCOMPATIBLE_DESTINATION 
INVALID_ACCOUNT_CODE 
KEY_CONFERENCE 
LOCKOUT 
MAINTENANCE 
NETWORK_CONGESTION 
NETWORK_NOT_OBTAINABLE 
NEW_CALL 
NO_AVAILABLE_AGENTS 
OVERRIDE 
RECALL 
REDIRECTED 
REORDER_TONE 
RESOURCES_NOT_AVAILABLE 
SILENT_MONITOR 
TRANSFER 
TRUNKS_BUSY 
VOICE_UNIT_INITIATOR 
<VARIES> 
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DeviceEvent Parameters Values 

OnIncomingCall 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CallID 
Device 
ANI 
CallingLength 
DNIS  
CallType 
 
 
 
Queue 
Cause 
 
 
 
 
 
 
 
      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
CollectedDigits 

<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
UNKNOWN 
ACD 
DIRECT 
ROUTE 
<VARIES> 
ALTERNATE 
BUSY 
CALLBACK 
CALL_CANCELLED 
CALL_FORWARD_ALWAYS 
CALL_FORWARD_BUSY 
CALL_FORWARD_NO_ANSWER 
CALL_FORWARD 
CALL_NOT_ANSWERED 
CALL_PICKUP 
CAMP_ON 
DESTINATION_NOT_AVAILABL
E 
DO_NOT_DISTURB 
INCOMPATIBLE_DESTINATION 
INVALID_ACCOUNT_CODE 
KEY_CONFERENCE 
LOCKOUT 
MAINTENANCE 
NETWORK_CONGESTION 
NETWORK_NOT_OBTAINABLE 
NEW_CALL 
NO_AVAILABLE_AGENTS 
OVERRIDE 
RECALL 
REDIRECTED 
REORDER_TONE 
RESOURCES_NOT_AVAILABLE 
SILENT_MONITOR 
TRANSFER 
TRUNKS_BUSY 
VOICE_UNIT_INITIATOR 

VARIES
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DeviceEvent Parameters Values 

 
 
 
 
 
 
 
 
 
 

TrunkGroup 
TrunkMember 
UUI 
Reason 
OrigANI 
OrigDNIS 
OrigCollectedDigits 
OrigUUI 
OrigUCID 
DistributingDevice 
UCID 
IIDigits 
FlexibleBilling 
RedirectionDevice 
 

<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 

OnLogin AgentDevice 
Agent Password 
Agent ID 
Group ID 

<VARIES> 
<VARIES> 
<VARIES> 
<VARIES> 

OnLogout Agent Device 
Agent ID 
Group ID 

<VARIES> 
<VARIES> 
<VARIES> 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Custom Events with AvayaEvent and AvayaCommand 

This optional feature will allow the administrator to  create a custom event for client-side 
operation. When this custom event is triggered, a customized response occurs on the 
Siebel Client. 
 

Example of a Custom Event 
Below is an example of a custom event. The following script (SaveCallData) saves the 
current call data, the sets the Parameter “EventToRaise” to “AvayaEvent.” This call data 
will be passed via “Avaya Command” (overleaf). 

• Enter the following script in Application Siebel Universal Agent Script in Siebel 
Tools. 

• Associate the script, using EventHandler and EventResponse, to an event in the 
Siebel Configuraton. For example, if you associate it with the OnIncomingCall 
Event, the call data will be saved and the EventToRaise Parameter will be set for 
every incoming call to that Siebel Client.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Option Explicit
Global CData(100, 100) as String
Global DataCount as Integer

Function SaveCallData() as Integer

Dim CTI as CTIService
Dim Data as CTIData
Dim x as Integer
Dim FieldName

set CTI = TheApplication.GetCTIService
set Data = CTI.GetCurrentCallData

DataCount = Data.GetCount
DataCount = DataCount - 1

For x = 1 to DataCount
FieldName = Data.GetFieldAt(x)
CData(x,1) = FieldName
CData(x,2) = Data.GetFieldValue(FieldName)

next x

DataCount = DataCount + 1

CData(DataCount,1) = "EventToRaise"
CData(DataCount,2) = "AvayaEvent"

SaveCallData = OperationComplete

End Function 
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Now it is time to create the script to call the event just created. The following script 
invokes "AvayaCommand" with call data saved. This script may be associated with a 
new button added in the appropriate Siebel view. 

 
 
 
 
 
 
 
  

 

 

 

 

 

 

 
Now, set EventHandler and EventResponse to handle  the raised custom event 
(“AvayaEvent”). 
 
 
 
 
 
 

Option Explicit
Global CData(100, 100) as String
Global DataCount as Integer

Sub AvayaCommand_Click
Dim CTI as CTIService
Dim Data as CTIData
Dim x as Integer
Dim FieldName as String
Dim FieldValue as String

set CTI = TheApplication.GetCTIService
set Data = CTI.CreateData

For x = 1 to DataCount
FieldName = CData(x,1)
FieldValue = CData(x,2)
Data.SetFieldValue FieldName, FieldValue

Next x

CTI.InvokeCommandWithData "AvayaCommand", Data
End Sub 
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Chapter 5: Administrator’s Quick Reference - Siebel 

Introduction 

For agents to be CTI-enabled, they must be present in both the Siebel and Avaya CT 
systems. Both products feature documentation with these instructions. For an easy 
reference, this chapter will give you a fast procedure for adding agents in both Avaya CT 
and Siebel.  
 

How This Section Is Organized 

• How to add agents in Siebel 7.0. 
• How to add agents in Avaya CT version 9. 
 

About This Section 

This is meant as a fast reference only, and does not cover the operations in the detail of 
the product manuals. You are strongly advised to read the product documentation for 
Siebel. 
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Accessing the Configuration Settings 

The first step is to specify the CTI Configuration File. This is done through the CTI 
Configuration Screen. Use this to export CTI configuration to a text file, import a new 
configuration, or make changes to existing CTI configurations from outside sources. 
1. Go to View ->Site Map (in the Siebel pull-down applet, not Internet Explorer).  

From  there, select the Communications Administration link and then select the ALL 
Configurations  Link. 

2. This will bring you into the ViewAll Configurations View. 
 

 
Figure 13 - All Configurations Screen 
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Importing the CTI Configuration from an Outside Source 

At this time, we will designate the CTI configuration file to be used with the telephony 
system. This is done as follows:  
1. Go to View ->Site Map (in the Siebel pull down applet, not Internet Explorer).  From  

there, select the Communications Administration link then select the ALL 
Configurations  Link.  

2. Confirm cursor is positioned on desired configuration, otherwise, an incorrect CTI 
configuration will be overlaid. 

3. Click on the Import button. 

4. In the Import Configuration window, select the Next button. 

5. Use Browse to select desired file location  and select the appropriate check boxes to 
determine what you will be importing(see fig6). 

6. Click on OK when the proper file has been located and the desired data has been 
selected.  

7. Siebel will now use this configuration file for CTI operations. 

 
Figure 14 - Importing Configurations 
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Exporting the CTI Configuration to an Outside Source 

When changes have been made to the CTI Configuration, the Configuration File must be 
saved. To save the CTI Configuration, follow this procedure: 
1. Go to View ->Site Map (in the Siebel pull down applet, not Internet Explorer).  From  

there, select the Communications Administration link then select the ALL 
Configurations  Link. 

2. Confirm cursor is positioned on desired configuration, otherwise, an incorrect CTI 
configuration will be exported. 

3. Click on the Export button. The Export Configuration screen will appear. 

4. Select the type of data you would like to export then click the Next button. 

5. Click OK to proceed.  

6. Once the export is complete you will be prompted for a name and location for your 
configuration (def) file. 

 

 
Figure 15 - Export Configuration screen 
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Setting up the CTI Agents Telesets 

Now, we will set up the agents to the proper telesets. This must be done within Siebel so 
that the system is aware of which teleset belongs to whom.  There is a one-to-many 
relationship between configuration and telesets. You may provide any sort of name or 
number for the telesets that will be unique within the same configuration. You can also 
use the same teleset number in multiple configurations. However, the telesets must match 
the ones set up on the Telephony Server devices (See Telephony Server Administration).  
1. First you must associate the agent with the CTI Configuration.  Do this by going to 

View-> Site Map  and selecting the Communications Administration link.  From 
there select the All Configurations link (below). 

 

 
Figure 16 – All Configurations Screen 

2. Select the Agents tab in the lower applet.  Click the New button and select the 
appropriate agents from the list. 
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3. Then select Agent General Profile from the “Show” drop down box.  Here you can 
set the appropriate agent Login ID and password.  Make sure to click the Save 
button after entering these values. 

 
Figure 17 – Agent General Profile Screen 

 
4. Then select All Telesets  from the “Show” drop down box.   

5. Click on the “Siebel Activity” button and select “New Record”.  Type the name of 
the teleset in the Teleset field. 
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6. Make sure the Agent tab is highlighted in the lower applet and click the new button.  
Then select the agents that you want to be associated with this teleset. 

 
Figure 18 – All Telesets Screen –Agents Tab 
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7. Click on the Extensions tab in the lower applet. Click on the “Siebel Activity” button 
for this applet and select “New Record”.  In the Extension field type the extension 
number to be associated with this teleset.  In the Extension Type field, select “S”. 

 

 
Figure 19 – All Telesets Screen – Extensions Tab 
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Chapter 6:  Administrator’s Quick Reference –  
Avaya  CT 

Introduction 
For agents to be CTI-enabled, they must be present in both the Siebel and Avaya CT 
systems. Both products feature documentation with these instructions. For an easy 
reference, this chapter will give you a fast procedure for adding agents in both Avaya 
CT and Siebel.  

Note: This is meant as a fast reference only, and does not cover the operations in 
the detail of the product manuals. You are strongly advised to read the product 
documentation for Siebel and Avaya CT. 

How This Section Is Organized 

• How to add agents in Siebel 7.0 
• How to add agents in Avaya CT. 

About This Section 

This is meant as a fast reference only, and does not cover the operations in the detail of 
the product manuals. You are strongly advised to read the product documentation for 
Avaya CT. 

Accessing the Telephony Server 

The telephony server works independent of Siebel, even though the two programs work 
closely together to provide computer telephony integration. It is important that the 
Telesets specified in Siebel match existing records in the TServer Administrator. You 
may also test the telephony server’s operational status through this application. 
1. Go to START -> PROGRAMS -> TS WIN32 CLIENT -> TELEPHONY SERVICES 

ADMIN 

2. Select correct Telephony Server from drop down (e.g., STLSBS01GE). (see Figure 20, 
overleaf) 
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3. Enter Telephony server Login and Password. 

4. Click OK. 

 
Figure 20 - Logging in to the TServer Administrator 

 
5. The Main Telephony Services Administrator screen will appear as diagrammed 

below after a successful login. 

 

 
Figure 21 - Main Telephony Services Administrator Screen 
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Adding New Devices to the TServer 

Devices must exist in the Telephony server before communication to Agent Access will 
function. If a teleset is added within Siebel, but not in this administrator, the teleset will 
not function properly. 
Any time a new teleset is added, log into the Tserver Administrator and add the new 
device by the following procedure: 
1. Go to Admin->Create Device 

2. Enter the Device ID, Device Type and TLink Group. 

3. Repeat for all devices. 
 

 
Figure 22 - Adding Devices to the TServer 

4. Click Apply after each entry, then click OK when finished. 
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Testing the TServer 

If calls do not go through, there may be an issue with the telephony server. This section 
instructs how to test the Telephony server outside of the Siebel Application. 
1. Go to START -> PROGRAMS -> TS WIN32 CLIENT -> TS TEST 

2. Select correct Telephony server from drop down  (e.g., 
AVAYA#AVAYA_ECS#CSTA#STLSBS01). 

3. Enter Telephony server User log-in and Password. 

4. Enter valid From extension (where the call originates). 

5. Enter valid To extension (destination of call). 

6. Select Dial. 

 
Figure 23 - Testing the TServer 

7. If the TServer Test succeeds, the screen should look as diagrammed. 

 
Figure 24 - TServer Test Passed 

 
8. If an error message appears informing that the call could not complete, chances are 

good that the TServer is down. For support on bringing the TServer back up, please 
call Avaya Technical Support at 1-800-242-2121. 
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We’d Like Your Opinion 
Avaya Inc. welcomes your feedback on this document.  Your comments can be of great 
value in helping us improve our documentation. 

Avaya CT® Integration for SIEBEL® 7.0 
Release 1.0  Version 1.0 Administrator’s Guide, Issue 6.0 December 2001 

1. Please rate the effectiveness of this document in the following areas: 
 Excellent Good Fair Poor 

Ease of Finding Information     
Clarity     
Completeness     
Accuracy     
Organization     
Appearance     
Examples     
Illustrations     
Overall Satisfaction     

2. Please check the ways you feel we could improve this document: 
! Improve the overview or introduction  ! Add more details 
! Improve the table of contents  ! Improve the organization  
! Add more step-by-step procedures  ! Add more figures  
! Add more troubleshooting information  ! Make it less technical 
! Add more examples  ! Make it more concise  
Please add details about your major concerns: _____________________________________ 
______________________________________________________________________________ 
______________________________________________________________________________ 
What did you like most about this document? _____________________________________ 
______________________________________________________________________________ 
______________________________________________________________________________ 
Feel free to write any comments below or on an attached sheet. ______________________ 
______________________________________________________________________________ 
______________________________________________________________________________ 
If we may contact you concerning your comments, please complete the following: 
Name: ___________________________________  Telephone Number: (___) _____________ 
Company/Organization: ____________________________________  Date: _____________ 
Address: _____________________________________________________________________ 
______________________________________________________________________________ 
Please fax your response to 720-444-8326. 
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